ABSTRACT

This document is provided with the DRV84x2_DRV82x2_DRV89x2-EVM User customer evaluation module (EVM) as a supplement to the DRV8462, DRV8962, and DRV8262 data sheets. This user's guide details the hardware implementation of the EVM and how to install the software packages.

Note

If you ordered a DRV8452EVM use hardware files for DRV8462EVM.
At the moment the silk screen has the following errata.

• The Silk screen says OUT3, it should say OUT4
• The Silk screen says OUT4, it should say OUT3

Table of Contents

1 Introduction ................................................................................................................................................................. 2
  1.1 Overview .......................................................................................................................................................... 2
  1.2 Purpose and Scope ........................................................................................................................................... 2
2 Jumpers Table and Setup ............................................................................................................................................. 3
3 Hardware Setup ........................................................................................................................................................ 10
4 Launching the DRV84x2_DRV82x2_DRV89x2-EVM GUI Application ................................................................. 13
5 GUI Operations DRV8462 .................................................................................................................................... 17
6 GUI Operations DRV8962 ..................................................................................................................................... 27
7 GUI Operations DRV8262 ..................................................................................................................................... 29
8 Updating Firmware ................................................................................................................................................... 31
9 Evaluation Hardware Overview ............................................................................................................................. 32

Trademarks

All trademarks are the property of their respective owners.
1 Introduction

1.1 Overview

The DRV84x2, DRV89x2, and DRV82x2 family of devices are a wide voltage, high power drivers ideal for a large range of industrial applications.

**DRV84x2: DRV8452 and DRV8462, Stepper Motor Driver with Autotorque, Silent Step Decay Mode, and Automatic Microstepping**

The auto-torque feature boosts system efficiency by adjusting the coil current according to the load torque. The standstill power saving mode automatically reduces power loss during motor hold condition. The silent step decay mode enables noiseless operation.

The internal current sense architecture eliminates the need for external sense resistors, therefore saving PCB area and system cost. The built-in indexer of the DRV8462 supports up to 1/256 microstepping, and the automatic microstepping mode interpolates the input STEP signal to reduce overhead on the controller MCU.

Sensor-less stall detection eliminates end stops from the system. The device supports protection and diagnostic features for robust and reliable operation.

**DRV89x2: DRV8952 and DRV8962, Four-channel Half-Bridge Driver with Current Sense Outputs**

The output stage of the device consists of N-channel power MOSFETs configured as four independent half-bridges, charge pump regulator, current sensing and regulation circuits, current proportional outputs and protection circuitry.

Integrated current sensing across the high-side MOSFETs allows the device to regulate the load current when the load is connected from output to ground. A regulation current limit can be set with an adjustable external voltage reference (VREF). Additionally, the device provides four proportional current output pins, one for each half-bridge high-side FET.

A low-power sleep mode is provided to achieve ultra-low quiescent current. Internal protection features are provided for supply under-voltage lockout (UVLO), charge pump under-voltage (CPUV), output over current (OCP), and device over-temperature (OTSD).

**DRV82x2: DRV8252 and DRV8262, Single or Dual H-Bridge Motor Drivers with Current Sense Output**

The device integrates two H-bridges. The two H-bridges can be paralleled together. Reference the data sheet for more information.

Similar to the DRV 89x2, integrated current sensing across the high-side MOSFETs allows the driver to regulate the motor current during start-up and high load events. A current limit can be set with an adjustable external voltage reference. Additionally, the device provides output current proportional to the motor current for each H-bridge. The integrated sensing uses a current mirror architecture, removing the need for large shunt resistors, saving board area and reducing system cost.

A low-power sleep mode is provided to achieve ultra-low quiescent current. Internal protection features are provided for supply under-voltage lockout (UVLO), charge pump under-voltage (CPUV), output over current (OCP), and device over-temperature (OTSD).

1.2 Purpose and Scope

This document is designed to be used as a start-up guide and to supplement the DRV84x2_DRV82x2_DRV89x2-EVM. The scope of this document is to provide the user with a guide to evaluate the DRV84x2_DRV89x2_DRV82x2 family of devices using a Graphical User Interface (GUI). The GUI application is required to control the EVM. This document covers the required EVM connections, configuration, and steps to use the GUI application for evaluation.
2 Jumppers Table and Setup

The jumppers J16-18 and J20 in the board are populated differently depending on which version of the board was ordered. This has done for simplicity's sake as you must simply populate all jumppers with jumper shunts.

Make sure to use jumper shunts to completely populate J4 and J8. J10 must be populated for there to be communication with the EZFET. Use the following Figure 2-1 to populate the following jumppers for all variants:

![Figure 2-1. Jumper Population Guideline](image)

Table 2-1. Jumper Identification Table

<table>
<thead>
<tr>
<th>Jumppers</th>
<th>DRV84X2</th>
<th>DRV89X2</th>
<th>DRV82X2</th>
</tr>
</thead>
<tbody>
<tr>
<td>J5</td>
<td>VREF with C2K</td>
<td>VREF with C2K</td>
<td>VREF with C2K</td>
</tr>
<tr>
<td>J6</td>
<td>VREF with MSP430</td>
<td>VREF with MSP430</td>
<td>VREF with MSP430</td>
</tr>
<tr>
<td>Jumpers</td>
<td>DRV84X2</td>
<td>DRV89X2</td>
<td>DRV82X2</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>J7</td>
<td>VREF manually</td>
<td>VREF manually</td>
<td>VREF manually</td>
</tr>
<tr>
<td>J4/J8</td>
<td>MCU Communication Jumpers</td>
<td>MCU Communication Jumpers</td>
<td>MCU Communication Jumpers</td>
</tr>
<tr>
<td>J10</td>
<td>EZFET Communication Jumper</td>
<td>EZFET Communication Jumper</td>
<td>EZFET Communication Jumper</td>
</tr>
<tr>
<td>J11</td>
<td>Micro USB Connection</td>
<td>Micro USB Connection</td>
<td>Micro USB Connection</td>
</tr>
<tr>
<td>J13</td>
<td>BOUT1/BOUT2</td>
<td>OUT3/OUT4</td>
<td>OUT3/OUT4</td>
</tr>
<tr>
<td>J14</td>
<td>AOUT1/AOUT2</td>
<td>OUT1/OUT2</td>
<td>OUT1/OUT2</td>
</tr>
<tr>
<td>J25</td>
<td>DNP</td>
<td>DNP</td>
<td>Disconnect for dual H Bridge Mode. Connect for single H Bridge mode, connects VREFs (Pin 33 and Pin 34 together.</td>
</tr>
<tr>
<td>J26</td>
<td>DNP</td>
<td>DNP</td>
<td>Disconnect for single H-Bridge Mode, Disconnects CREF2 from MSP430 in single H Bridge mode. Leave connected for dual H Bridge mode.</td>
</tr>
<tr>
<td>J19</td>
<td>DNP</td>
<td>DNP</td>
<td>Not working properly at the moment. Do not populate. Instead connect the driver side of J18 and J17 with a jumper cable to connect IPROPIs together</td>
</tr>
</tbody>
</table>

**Note**

Jumpers J16-J20 placement will vary depending on the different variants. Make sure to follow the following schematics to ensure functioning of each variant.
Figure 2-2. DRV84X2EVM Current Regulation Jumpers 3D View
Figure 2-3. DRV84X2EVM Current Regulation Jumpers Schematic

Figure 2-4. DRV89x2EVM Current Regulation Jumpers 3D View
Figure 2-5. DRV89x2EVM Current Regulation Jumpers Schematic
Figure 2-6. DRV82x2EVM Current Regulation Jumpers 3D View
For more detailed information be sure to download the hardware files and schematics. Once you have verified that all shunts and jumpers are in the correct location you can move on to hardware setup.
3 Hardware Setup

1. Connect the USB cable to J11 of the EVM and a computer.
2. If utilizing the Stepper Motor Driver, connect the stepper motor to screw terminal connectors J13 and J14. A-phase can be connected to J14 and B-phase to J13. If using the dual half bridge driver, or the half bridge driver use terminals J13 and J14 as indicated to connect in the desired setup.

Figure 3-1. External Connections
WARNING
At the moment the silk screen has the following errata:
• The Silk screen says OUT3, it should say OUT4
• The Silk screen says OUT4, it should say OUT3

4. Observing correct polarity connect the lab power supply to the large screw terminal block J12. CAUTION:

CAUTION
A reverse polarity connection can permanently damage the EVM hardware and can cause a fire hazard and / or personal injury.

VM in the left, GND on the right. VM is connected to the fuse.
5. Set the lab supply for 12 V and enable output on lab supply. If the unit displays current consumption, there should be approximately 20 mA drawn from the lab supply at this state.

6. Verify the 3V3 LED D5 and VM LED D4 are illuminated. The nFAULT LED D7 may flash momentarily when VM power is switched on.

7. Verify MCU Status LED D6 is blinking at approximately 1 Hz. If the STATUS LED is not blinking perform a firmware reset using the push button S1 with jumper J27 in 1-2 RST position. The MCU_STATUS LED D6 will blink now if the EVM hardware is functioning normally.

8. The EVM is ready to be used with the GUI application (Launching the DRV84x2_DRV82x2_DRV89x2-EVM GUI Application). In certain situations, such as while disconnecting and reconnecting VM power before the power supply capacitors are fully discharged a proper firmware reset can fail to happen. A proper reset is indicated by the STATUS LED D6 blinking at a rate of approximately 1 Hz. If the Status LED is not blinking as expected, press the reset push button once with jumper J27 installed in the RST position.

9. Do not unplug the USB cable while the VM power is active. If you do, switch off the VM power, wait until the VM power is fully discharged and proceed to step 2. The latest version of the GUI application is bundled with the latest version of the EVM firmware.

10. A firmware update is suggested before selecting and connecting to an EVM variant using the GUI application. The firmware update procedure is described in the updating firmware section of this User's Guide.
4 Launching the DRV84x2_DRV82x2_DRV89x2-EVM GUI Application

Whether using the desktop or web version of the GUI, the user experience and steps covered below will be the same. It is assumed the hardware setup steps in the previous section have already been completed.

1. Launch the GUI application using Chrome web browser or from your local desktop installation. Note you’ll have to log-in to the TI Dev Gallery using your myTI log-in credentials prior to launching the app while running from a web browser.
   a. Hyperlink for running app in Chrome: Web GUI

2. From the screen referenced in Figure 4-1

Device selection screen within GUI

![EVM Selection](image)

Figure 4-1. DRV84x2_DRV82x2_DRV89x2-EVM GUI Home Screen

3. After clicking the correct EVM type, the GUI application will initiate communications with the EVM. Connection confirmation will be displayed as shown below in Figure 4-2:
4. If the GUI app connection with the EVM is repeatedly not successful, follow the below listed steps to debug the issue.
   a. Check if the serial communications parameters were properly configured. In the GUI, click on the “Options” menu, and select “Serial Port”. Verify if the port selected matches the MSP Application UART1 enumerated in the Device Manager, Windows system Control Panel. The baud rate must be set to 9600 (recommended). If no MSP COMxx ports were enumerated and displayed in the Windows Device Manager, ensure proper power sequencing was followed. If necessary do a power off and on cycle. If the following Windows Device Manager information is still not visible after the power cycle it points to a hardware connection issue.

Figure 4-2. Successful EVM Connection
b. It is possible that the EVM has a much older version of the firmware. Perform a firmware update using the procedure described in Updating Firmware

c. Check if the MCU_STATUS LED D6 is blinking at approximately 1 Hz. If the STATUS LED is not blinking, perform a firmware reset using the push button S1 with jumper J23 in 1-2 RST position. Attempt to connect the GUI app with the EVM again.

5. At this point, the user may set-up the EVM for device evaluation:
   • Driver Control page with configuration and diagnostic options.
   • GUI Home page to re-select the EVM if necessary.
6. The "Driver Control" tab will display the firmware version in the top right corner. When you click on "Help > About" it should display the GUI version, Device Rev ID, and the EVM firmware version.

7. Using the DRV8462 as an example, go to the “STEPPER MOTOR CONTROL” tab in the “Driver Control” page. Set the “Motor Driver” to “Awake” and “Driver Outputs” to “Enabled”. With default settings click on the “Start Input-based STEP” button. The motor should spin in one direction. Change the direction using the “Input-based Direction” control. The motor should spin in the opposite direction.
5 GUI Operations DRV8462

1. Go to the “STEPPER MOTOR CONTROL” tab in the “Driver Control” page. Set the “Motor Driver” to “Awake” and “Driver Outputs” to “Enabled”. With default settings click on the “Start Input-based STEP” button. The motor should spin in one direction. Change the direction using the “Input-based Direction” control. The motor should spin in the opposite direction.

2. The “Register Map” menu will display all the device Registers. Register values can be modified directly either using the “Field View” panel or by changing the hexadecimal data displayed in the “Value” column.

3. All Registers settings can be saved as a ‘regs.json’ file using the “File” menu “Save Registers” option. The saved values can be loaded back to the Registers from the saved ‘regs.json’ file using the “File” menu “Load Registers” option.

4. The device features can be evaluated using the tabs in the “Driver Control”
5. Refer to the DRV8462 “ADVANCE INFORMATION” data sheet to understand the integrated features of the stepper motor driver device. Only the key features are described below. The GUI provides access to all the features in the device.

a. **Stand Still Power Saving:** This feature defines the hold current level while the motor is in stand still. Typically, hold current required can be significantly lower than run current. This feature will save power as well as avoid unnecessary heating of the motor. The default setting for the “Stand Still Current” is 50% of the run current defined by “Torque DAC Setting” and “Full Scale Current”. The minimum value that can be input is 1%. Enable this feature and set the desired hold current value as well as required delay times designed for your application.
AUTO-MICROSTEPPING: When enabled, this feature automatically interpolates the step input pulses to the selected auto microstepping modes in the drop-down menu of RES_AUTO.

STEP EDGE: This setting selects the step input response to either rising edge or both edges. The default setting is rising edge. When "Both Edges" option is selected, the motor will step with double the target speed. Set the "Target Speed" accordingly to avoid a motor stall.

CONTROL MODE: This is a GUI app feature which allows selection between "Speed" mode and "Step" mode. In speed mode, the motor will run at the set target speed using the defined acceleration and deceleration rate motion profile. In "Step" mode, the motor can be stepped to the desired position by setting the required number of steps at the set target speed. When target speed is set to 1 PPS (pulse per second) set...
Setting the starting, stopping, acceleration rate and target speed to the same value will start motor directly at the target speed.

Stall Detection: This feature can be enabled by using the “Initiate Stall” slide switch. While enabled, all stall detection settings and features are revealed by the GUI. Stall detection can be used in either learn mode which automatically learns the stall threshold value using a learn procedure or manual stall threshold value entry mode by disabling the “Learn Mode”.

Figure 5-7. Control Mode

Figure 5-8. Input Based STEP Control Panel
e. Stall Detection: This feature can be enabled by using the “Initiate Stall” slide switch. While enabled, all stall detection settings and features are revealed by the GUI. Stall detection can be used in either learn mode which automatically learns the stall threshold value using a learn procedure or manual stall threshold value entry mode by disabling the “Learn Mode”.

Figure 5-9. Stall Detection
Stall detection requires the drive to operate in Smart Tune Ripple Control Decay mode which is the default setting of the device. The Decay mode can be modified using the “Decay Mode” GUI push button in the STEPPER MOTOR CONTROL tab. Test point A3 on the EVM outputs an analog voltage equivalent to the Torque Count updated once every 8 ms. Torque Count = (Output Voltage x 4095) / 3.3.

![Decay Mode](image)

**Figure 5-10. Decay Mode**

The GUI app has a feature to disable stall detection during acceleration. The default setting for this is “Disabled”. Wait for the acceleration to complete which is indicated by the LED D10 off, before performing a stall threshold learn.

---

**Note**

The torque count is 4095 when the stall detection is disabled during acceleration. After the acceleration is completed, stall detection is automatically enabled and the actual torque count is displayed.

---

In the learn mode, run the stepper motor at the desired target speed with no load. Wait for the “Stall Detection” message “Please stall motor to complete Stall Threshold learning sequence” and “Relearn Stall Threshold” push button to appear. Then manually stall the motor by safely using a pair of pliers with soft jaws or if you are using a linear system with mechanical travel end hard stop positions, allow the motor to hit the physical stop.

![Stall Threshold Learning](image)

**Figure 5-11. Stall Threshold Learning**

A successful stall threshold learning will be indicated by a check mark icon and text “Stall threshold learning sequence complete”. A relearn can be done at any time by pressing the “Relearn Stall Threshold” button. If the “Active Stall Detection” is set to “Stop driving after stall” and “Reverse direction on stall fault” to off, which happen to be the default setting, the motor will stop immediately after a learning is completed and the “Stall Detection” indicator in the GUI status panel will turn red. The motor can be run again after pressing the “Clear” button to the right of the Fault Status indicator in the GUI. If you want to keep driving after stall you can enable it below.
In manual stall threshold entry mode run the motor with “Stall Threshold” slider set to zero. The torque count it displayed as well as plotted in the graph vs. time. Use the x8 multiplier if the torque count is low while using high DCR stepper motors.

**Note**
The torque count and set the threshold to 50 % of the torque count value or lower. Follow the same procedure as in the learn mode operation to detect a motor stall. Pressing the “Export Torque Count Values” exports 512 values of the historical torque count to an Excel file.

**Custom microstepping:** To setup and enable this feature CUSTOM MICROSTEPPING tab should be used. Custom microstepping allows the user to define a custom current waveform other than the sine wave defined by the integrated microstepping indexer. When custom microstepping is enabled the integrated microstepping settings are ignored by the driver regardless of its setting.

A drop down menu allows the user to choose between “User defined” (default) or three other preset options available in the GUI. This is a GUI feature provided for ease of use. Click on the desired option, for example “Triangular” to automatically populate the Registers CUSTOM_CURRENT1 to CUSTOM_CURRENT8. Registers CUSTOM_CURRENT1 to CUSTOM_CURRENT8 define the first quadrant of the electrical cycle of the phase currents. Rest of the quadrants are automatically populated by the device including the zero values of the full electrical cycle. If the “User defined” option is selected, enter the values for a desired waveform. Enable the “Custom-microstepping” slide switch after the Registers are populated with the required values.
Figure 5-14. Custom Microstepping

**g. Silent step Decay mode:** To setup and enable this feature SILENT STEP tab should be used.

---

**Note**

Stall Detection will work only in Smart Tune Ripple Control Decay mode. Disable stall detection while Silent Step Decay Mode is used.

Set the “Silent Step Decay Mode” slide switch to “Enabled”. Select the desired silent step transition threshold step rate for your application. Start with a KP value of 32 and fine tune KP and KI to suit your application. Silent step decay mode benefits low stepping rate operation of the motor especially with low microstepping settings such as 1/4, 1/2, and Full step.

Use the following procedure to demonstrate this feature. Start with the default settings of the GUI in “Speed” Control Mode. Reduce the “Target Speed” to 2000 PPS and change “Step Mode” to 1/4 Step. Run the stepper motor. While running with these settings the motor usually generates an audible noise. Switch to the SILENT STEP tab. Set the “Silent Step Decay Mode” slide switch to “Enabled”. Select the “Silent Step Transition Threshold” to 4000 PPS. Set a KP value of 32. The motor will run quietly.
Auto Torque: To setup and enable this feature AUTO TORQUE tab should be used. The following example describes setting up Auto Torque with a J-4218HB2401 NEMA17 bipolar Stepper motor rated 1.7 A, commonly used in 3D printers. A 24 V power supply with > 3 A current rating is used for powering the EVM.

i. Start with the default settings of the EVM. Performing an EVM firmware reset using push button S1 will ensure all the default settings of the EVM are loaded. Click on the DRV8462EVM icon from the GUI home page to establish connection between the GUI app and the EVM.

ii. Go to the “Motor Control” menu in the left-hand side menu bar. Set “Motor Driver” to “Awake”. Increase the Full-Scale Current setting to 2 A in the STEPPER MOTOR CONTROL tab. Set “Driver Outputs” to “Enable”. Start the motor using the “Start Input based STEP” push button.

iii. Switch to the AUTO TORQUE tab of the GUI. Enable Auto Torque mode using the slide switch.

iv. Next, while the motor is running unloaded and with the default settings of the “Learn” parameters, initiate a learn by pressing the “Auto Torque Learn” push button. A green check mark with text “Learn Completed” will appear as soon as the learning is completed. Relearning can be done at any time with the motor running unloaded at any time by pressing the “Auto Torque Learn” push button.

v. Configure the minimum and maximum current limit values in “Loop Regulation” section. These are 8-bit integer values, 0 to 255 in decimal. Set the minimum current limit value to 48 which will be equal to (48/256) * 2 A or 375 mA. With 375 mA drive current, this stepper motor will have sufficient...
torque to run with a light load without losing steps or stalling. This is the criteria for choosing the minimum current limit value in an application. Set the maximum current limit value to 192 which will be equal to (192/256) * 2A or 1.5A. A higher maximum value can be chosen if needed by the application. Auto torque will allow over driving the motor for short periods of time during transient higher load torque.

Figure 5-16. Auto Torque Control Panel

vi. Now, observe the “Auto Torque Count” values with no load. Use the range of values observed to set the Auto Torque Count upper and lower limits. The auto-torque algorithm maintains the ATQ_CNT value within the hysteretic band defined by ATQ_UL and ATQ_LL, by modulating the full-scale current between 375 mA and 1.5 A.
vii. Please refer to the DRV8462 "ADVANCE INFORMATION" data sheet for detailed description of the Auto Torque feature including details on how to setup and tune its operation to suit your application.

6. In addition to the SPI interface-based Register controlled operation, the DRV8462 device also supports GPIO controlled operation described in the device data sheet. The GUI also allows operating the device in this mode. The GUI comes up with "SPI" controlled operation by default. To operate the device with GPIO control select “H/W” in the “Interface Mode” selector in the STEPPER MOTOR CONTROL tab. The selector can be changed only while the “Motor Driver” slide switch is in “Asleep” position.

Figure 5-17. Interface Mode Control Panel
6 GUI Operations DRV8962

1. If not done so already turn off the power supply and connect your motors to the EVM in the desired configuration. Both high side and low side load driving is possible and is open to the user to configure. Use Jumpers J13 and J14 to connect the motors to the half bridges and J23 for VM and GND.

2. Go to the “LOAD CONTROL” tab in the “Driver Control” page. The VM Voltage widget will read out the input voltage to J12. Set the “Motor Driver” to “Awake”. Using the drop-down menu displaying “Hi-Z” choose “Low Side Load” for HB1, HB2, HB3 and HB4.

3. Press all the four “Start Drive 1,2,3 and 4” buttons. The HB1, HB2, HB3 and HB4 PWM INPUTS sliders will turn active now. First set IN1 Duty Cycle to 50%. Motor-1 will start spinning and the motor current will be displayed in the HALF-BRIDGE-1 display window. Next set IN2 Duty Cycle to 100% from the HB2 tab. Motor-1 will slow down to zero speed and reverse direction. Now the motor current will be displayed in the HALF-BRIDGE-2 display window. Repeat these steps for HB3 with 50% duty cycle and HB4 with 100% duty cycle. This will spin Motor-2 and the currents will be displayed in HALF-BRIDGE-3 and HALF-BRIDGE-4 display windows similar to Motor-1. Switch the “Motor Driver” widget to “Asleep”. The motors will spin down to a stop.

4. The section on the right will allow you to monitor the Output Status of each half bridge, clear faults, set the PWM frequency, set the OCPM mode, output rise/fall time, and VREF for current regulation. Make sure to only make this changes when the outputs are disabled. Changes might not be reflected if changed mid drive.
Figure 6-2. DRV8962 Monitor Panel
7 GUI Operations DRV8262

1. If not done so already turn off the power supply and connect the two brushed DC motors to the EVM screw terminal blocks J13 and J14. Alternatively in single H Bridge mode connect a single motor to terminal J14. First motor, Motor-1 pair of wires should be connected to J14 and the second motor, Motor-2 pair of wires should be connected to J13. Turn on the lab power supply. Be sure to switch off the lab power supply when swapping the motor connections. Note: If only one motor is available the tests can be conducted for one motor at a time, first for the motor connected to J14 and next for the motor connected to J13.

2. Go to the “LOAD CONTROL” tab in the “Driver Control” page. The VM Voltage widget will read out the input voltage to J12. Leave MODE1 and MODE2 settings in its default value. Set the “Motor Driver” to “Awake”.

3. Press the two “Start Drive 1 and 2” buttons. Leave the “Direction” setting in its default position. Rest of the settings during these tests should be left with default positions and values. First set IN1 Duty Cycle to 50%. Motor 1 will start spinning in one direction and the motor current will be displayed in the BRIDGE-1 CURRENT display window. Change the “Direction” setting. The motor speed will ramp down to a standstill and then change direction and ramp up speed corresponding to 50% duty cycle. The motor current will be displayed in the BRIDGE-1 CURRENT display window. Press the “Stop Drive 1” button. The motor will ramp down and stop.

4. Next set IN3 Duty Cycle to 50%. Motor 2 will start spinning in one direction and the motor current will be displayed in the BRIDGE-2 CURRENT display window. Change the “Direction” setting. The motor speed will ramp down to a standstill and then change direction and ramp up speed corresponding to 50% duty cycle. The motor current will be displayed in the BRIDGE-2 CURRENT display window. Press the “Stop Drive 2” button. The motor will ramp down and stop. Switch the “Motor Driver” widget to “Asleep”.

Figure 7-1. Driver Control Page
5. Using the MODE2 drop down menu choose “Pulse Width Modulation (PWM)” setting. This is where you can also choose between Dual H Bridges vs Single H Bridge allowing for higher current.

6. The LOAD CONTROL window will change to PWM control mode with four PWM settings sliders.
8 Updating Firmware

Your EVM includes the ability to update the MCU firmware controlling the DRV84x2_DRV82x2_DRV89x2EVM
device without any additional hardware. There should be a pop-up every time the GUI Driver Control page is
selected after an EVM connection is made and if a new update becomes available as can be seen in EVM
Firmware Update Pop-Up.

![EVM Firmware Update Available!](image)

A new firmware update is available for the EVM hardware. Upgrade to the new version using the 'Program Device' function in the 'File' menu from the 'EVM Home' screen of the GUI.

Figure 8-1. EVM Firmware Update Pop-up

The user can update the EVM to the latest firmware by simply going to File -> Program Device from either the
EVM Home Page or the Driver Control page as shown in Figure 8-2.

Successful firmware update will bring up a message window stating "Flash Successful!".

Figure 8-2. Update Firmware

![EVM Selection](image)
9 Evaluation Hardware Overview

CAUTION
Hot surfaces on the EVM include the DRV824x-Q1 or DRV814x-Q1 device (U1) and the area surrounding it.

When operating the EVM at the maximum device specifications and a high ambient temperature, external cooling fans may be required to minimize potential fire hazard, personal injury, or both.
STANDARD TERMS FOR EVALUATION MODULES

1. **Delivery:** TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.

1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions set forth herein but rather shall be subject to the applicable terms that accompany such Software.

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned, or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production system.

2. **Limited Warranty and Related Remedies/Disclaimers:**

2.1 These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License Agreement.

2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM to User. Notwithstanding the foregoing, TI shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications or instructions for such EVMs or improper system design, or (c) User has not paid on time. Testing and other quality control techniques are used to the extent TI deems necessary. TI does not test all parameters of each EVM.

User's claims against TI under this Section 2 are void if User fails to notify TI of any apparent defects in the EVMs within ten (10) business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.

2.3 TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day warranty period.

---

**WARNING**

Evaluation Kits are intended solely for use by technically qualified, professional electronics experts who are familiar with the dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.

User shall operate the Evaluation Kit within TI's recommended guidelines and any applicable legal or environmental requirements as well as reasonable and customary safeguards. Failure to set up and/or operate the Evaluation Kit within TI's recommended guidelines may result in personal injury or death or property damage. Proper set up entails following TI’s instructions for electrical ratings of interface circuits such as input, output and electrical loads.

NOTE:
EXPOSURE TO ELECTROSTATIC DISCHARGE (ESD) MAY CAUSE DEGREDATION OR FAILURE OF THE EVALUATION KIT; TI RECOMMENDS STORAGE OF THE EVALUATION KIT IN A PROTECTIVE ESD BAG.
Regulatory Notices:

3.1 United States

3.1.1 Notice applicable to EVMs not FCC-Approved:

FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software associated with the kit to determine whether to incorporate such items in a finished product and software developers to write software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference. Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.

3.1.2 For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

FCC Interference Statement for Class A EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

FCC Interference Statement for Class B EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada

3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247

Concerning EVMs Including Radio Transmitters:
This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

Concernant les EVMs avec appareils radio:
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:
Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated. Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited for use with this device.
Concernant les EVMs avec antennes détachables
Conformément à la réglementation d’Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d’un type et d’un gain maximal (ou inférieur) approuvé pour l’émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage radioélectrique à l’intention des autres utilisateurs, il faut choisir le type d’antenne et son gain de sorte que la puissance isotrope rayonnée équivalente (p.i.r.e.) ne dépasse pas l’intensité nécessaire à l’établissement d’une communication satisfaisante. Le présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d’antenne énumérés dans le manuel d’usage et ayant un gain admissible maximal et l’impédance requise pour chaque type d’antenne. Les types d’antenne non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l’exploitation de l’émetteur.

3.3 Japan

3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lsds/ft_ja/general/eStore/notice_01.page 日本国内に輸入される評価用キット、ボードについては、次のところをご覧ください。
http://www.tij.co.jp/lsds/ft_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs (which for the avoidance of doubt are stated strictly for convenience and should be verified by User):

1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for Enforcement of Radio Law of Japan,

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.

【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けていないものがあります。技術基準適合証明を受けていないもののご使用に際しては、電波法遵守のため、以下のいずれかの措置を取っていただく必要がありますのでご注意ください。

1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用いただく。

2. 実験局の免許を取得後ご使用いただく。

3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ft_ja/general/eStore/notice_02.page

電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧ください。

3.4 European Union

3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive): This is a class A product intended for use in environments other than domestic environments that are connected to a low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this product may cause radio interference in which case the user may be required to take adequate measures.
EVM Use Restrictions and Warnings:

4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.

4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:

4.3.1 User shall operate the EVM within TI's recommended specifications and environmental considerations stated in the user guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or property damage. If there are questions concerning performance ratings and specifications, User should contact a TI field representative prior to connecting interface electronics including input power and intended loads. Any loads applied outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative. During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit components may have elevated case temperatures. These components include but are not limited to linear regulators, switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the information in the associated documentation. When working with the EVM, please be aware that the EVM may become very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the dangers and application risks associated with handling electrical mechanical components, systems, and subsystems. User assumes all responsibility and liability for compliance with proper and safe handling and use of the EVM by User or its employees, affiliates, contractors or designers. User assumes all responsibility and liability to ensure that any interfaces (electronic and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or designers.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal, state, or local laws and regulations related to User's handling and use of the EVM and, if applicable, User assumes all responsibility and liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as accurate, complete, reliable, current, or error-free.

6. Disclaimers:

6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL FAULTS." TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE CONSTRUED AS GRANTING OR CONFOGGING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSES OR ANY OTHER THIRD PARTY, TO USE THE EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7. User's Indemnity Obligations and Representations. User will defend, indemnify and hold TI, its licensors and their representatives harmless from and against any and all claims, damages, losses, expenses, costs and liabilities (collectively, "Claims") arising out of or in connection with any handling or use of the EVM that is not in accordance with these Terms. This obligation shall apply whether claims arise under statute, regulation, or the law of tort, contract or any other legal theory, and even if the EVM fails to perform as described or expected.
8. Limitations on Damages and Liability:

8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE TERMS OR THE USE OF THE EVM(S), REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING, OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS OCCURRED.

8.2 Specific Limitations. IN NO EVENT SHALL TI’S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMNITY OR OTHER OBLIGATION ARISING OUT OF OR IN CONNECTION WITH THESE TERMS, EXCEED THE TOTAL AMOUNT PAID TO TI BY USER FOR THE PARTICULAR EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9. Return Policy. Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s) will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s), excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas, without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas. Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2019, Texas Instruments Incorporated
IMPORTANT NOTICE AND DISCLAIMER

TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATA SHEETS), DESIGN RESOURCES (INCLUDING REFERENCE DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS” AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD PARTY INTELLECTUAL PROPERTY RIGHTS.

These resources are intended for skilled developers designing with TI products. You are solely responsible for (1) selecting the appropriate TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable standards, and any other safety, security, regulatory or other requirements.

These resources are subject to change without notice. TI grants you permission to use these resources only for development of an application that uses the TI products described in the resource. Other reproduction and display of these resources is prohibited. No license is granted to any other TI intellectual property right or to any third party intellectual property right. TI disclaims responsibility for, and you will fully indemnify TI and its representatives against, any claims, damages, costs, losses, and liabilities arising out of your use of these resources.

TI’s products are provided subject to TI’s Terms of Sale or other applicable terms available either on ti.com or provided in conjunction with such TI products. TI’s provision of these resources does not expand or otherwise alter TI’s applicable warranties or warranty disclaimers for TI products.

TI objects to and rejects any additional or different terms you may have proposed.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2022, Texas Instruments Incorporated